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Аннотация дисциплины 

«Прикладное программирование в приборостроении» 

 

Дисциплина «Прикладное программирование в приборостроении» 

разработана для студентов, обучающихся по направлению подготовки 

12.03.01 Приборостроение по профилю «Акустические приборы и системы», 

входит в вариативную часть обязательных дисциплин Блока 1 Дисциплины 

(модули) учебного плана (Б1.В.ОД.3). 

Общая трудоемкость освоения дисциплины составляет 288 часов (8 

зачетных единиц). Учебным планом предусмотрены лекции (36 часов), 

лабораторные работы (36 часов), практические занятия (54 часа), 

самостоятельная работа студента (81 час), контроль (81 час). Дисциплина 

реализуется на 1 и 2 курсах во 2 и 3 семестрах. Оценка результатов обучения: 

экзамен во 2 и в 3 семестрах. 

Дисциплина «Прикладное программирование в приборостроении» 

опирается на уже изученные дисциплины, такие как «Математика», 

«Информатика в приборостроении», «Физика». В свою очередь она является 

«фундаментом» для изучения профессиональных дисциплин. 

Целью дисциплины является получение знаний в области 

технических, базовых и прикладных программных средств, информационных 

систем, языков программирования высокого уровня, необходимых при 

проектировании, в технических расчетах, при оформлении документации. 

Задачи дисциплины:  

- приобретение студентами основных знаний об устройстве 

персонального компьютера;  компьютерных программах общего назначения; 

специализированных компьютерных программах. 

Для успешного изучения дисциплины «Прикладное программирование 

в приборостроении» у обучающихся должны быть сформированы следующие 

предварительные компетенции:  



- способность осуществлять поиск, хранение, обработку и анализ 

информации из различных источников и баз данных, представлять ее в 

требуемом формате с использованием информационных, компьютерных и 

сетевых технологий; 

- способность выявлять естественнонаучную сущность проблем, 

возникающих в ходе профессиональной деятельности, привлекать для их 

решения соответствующий физико-математический аппарат; 

- способность обрабатывать и представлять данные экспериментальных 

исследований. 

Планируемые результаты обучения по данной дисциплине (знания, 

умения, владения), соотнесенные с планируемыми результатами освоения 

образовательной программы, характеризуют этапы формирования 

следующих компетенций: 

Код и формулировка 

компетенции 
Этапы формирования компетенции 

ОПК-2 

Способность осуществлять поиск, 

хранение, обработку и анализ 

информации из различных 

источников и баз данных, 

представлять ее в требуемом 

формате с использованием 

информационных, компьютерных 

и сетевых технологий 

Знает как осуществлять поиск, хранение, 

обработку и анализ информации из 

различных источников и баз данных, 

представлять ее в требуемом формате 

с использованием информационных, 

компьютерных и сетевых технологий 

Умеет осуществлять поиск, хранение, 

обработку и анализ информации из 

различных источников и баз данных, 

представлять ее в требуемом формате 

с использованием информационных, 

компьютерных и сетевых технологий 

Владеет навыками работы по поиску, 

хранению и обработке информации 

ОПК-7 

Способность использовать 

современные программные 

средства подготовки 

конструкторско-технологической 

документации 

Знает Методы информационных технологий 

Умеет использовать компьютерную технику 

для решения инженерных задач 

Владеет навыками работы с программными 

средствами управления 

экспериментом и обработкой данных 

ОПК-9 

Способностью владеть методами 

информационных технологий, 

соблюдать основные требования 

информационной безопасности, в 

том числе защиты государственной 

тайны 

Знает Методы информационных технологий 

Умеет Работать с программными пакетами 

Владеет 

Программными средствами 

управления экспериментом и 

обработки данных, и методами 

информационных технологий, 

программным пакетом LabView 



ПК-1 

Способностью к анализу 

поставленной задачи исследований 

в области приборостроения 

 

Знает методы и средства математического 

анализа, методы математической 

статистики для проведения анализа 

поставленной задачи исследований в 

области приборостроения 

Умеет использовать методы и средства 

математического анализа, и методы 

математической статистики для 

проведения анализа поставленной 

задачи исследований в области 

приборостроения 

Владеет навыками работы с методами и 

средствами математического анализа, 

методами математической статистики 

для проведения анализа поставленной 

задачи исследований в области 

приборостроения  

ПК-2 

Готовность к математическому 

моделированию процессов и 

объектов приборостроения и их 

исследованию на базе стандартных 

пакетов автоматизированного 

проектирования и самостоятельно 

разработанных программных 

продуктов 

Знает Основы математического 

программирования в программных 

пакетах Mathcad и Matlab 

Умеет работать с программными средствами 

математического программирования 

Владеет Навыками работы с программными 

средствами математического 

программирования и 

автоматизированного проектирования 

 

Для формирования вышеуказанных компетенций в рамках дисциплины 

«Прикладное программирование в приборостроении» применяются 

следующие методы активного обучения: проблемное обучение, 

проектирование, консультирование и рейтинговый метод. 

 

I. СТРУКТУРА И СОДЕРЖАНИЕ ТЕОРЕТИЧЕСКОЙ ЧАСТИ КУРСА 

(18 час.) 

 

Раздел I Персональный компьютер (4 час.) 

Тема 1. Персональный компьютер (4 час.) 

Понятие информации, сигнал, сообщение, данные, понятие количества 

информации. ЭВМ как средство обработки информации: понятие 

архитектуры ЭВМ, классификация ЭВМ, структура и принципы 

функционирования ЭВМ, основные характеристики вычислительной 



техники. Виды программного обеспечения ЭВМ. Перспективы развития 

вычислительных средств. Персональный компьютер: определение, история 

развития, устройство современного персонального компьютера. Процессор: 

принципы работы, конвейерная архитектура, процессорная шина, 

кэширование, параллельная архитектура. Чипсет: устройство, состав, 

принцип работы. Материнская плата, Шина: определение, виды, их 

эволюция, принципы работы. Операционная система. Конфигурирование 

системы: панель управления, средства управления системой, утилиты 

командной строки. Системный реестр, его назначение, структура. Средства 

резервного копирования и восстановления Windows. Сетевые подключения: 

типы, управление, подключение к локальной вычислительной сети. 

Программы-оболочки. Антивирусная защита. Компьютерная сеть, Internet. 

Компьютерная сеть: определение, модель OSI, протоколы. Сеть Ethernet: 

история развития, принцип, метод доступа, стандарты. 

 

Раздел II Математические программные пакеты Mathcad и Matlab (9 

час.)  

Тема 1. Математический программный пакет Mathcad (4 час.) 

Общая характеристика, отличительные черты, преимущества и 

недостатки. Интерфейс, меню, основные настройки. Ввод информации, 

определение переменных, встроенные и пользовательские функции, 

спецфункции. Операторы, типы данных, формат вывода числовых данных. 

Массивы, ранжированные переменные. Символьные вычисления в Mathcad. 

Программные блоки в Mathcad. Интегрирование и дифференцирование. 

Решение обыкновенных дифференциальных уравнений. 

Тема 2. Математический программный пакет Matlab (5 час.) 

История создания, общая характеристика, отличительные черты, 

преимущества и недостатки. Общие принципы работы с пакетом Matlab, 

окна, запуск m-файлов пользователя, вывод файла помощи. Меню, панель 

инструментов. Основы редактирования и отладки m-файлов, понятие о 



файлах-сценариях и файлах-функциях. Ввод информации, определение 

переменных, встроенные и пользовательские функции, спецфункции. 

Операторы, типы данных, формат вывода числовых данных. Основы 

графической визуализации вычислений. Операции с векторами и матрицами. 

Численные методы в MATLAB. Интегрирование  и дифференцирование. 

Решение обыкновенных дифференциальных уравнений. Преобразование 

Фурье. 

Раздел III Программные средства управления экспериментом и 

обработки данных (5 час.)  

Тема 1. Программный пакет LabView (5 час.) 

Общая характеристика, отличительные черты, преимущества и 

недостатки. Интерфейс, меню, основные настройки. Ввод информации, 

встроенные и пользовательские функции, спецфункции. Операторы, типы 

данных, формат вывода числовых данных. Виртуальные приборы. Основы 

графической визуализации. 

 

II. СТРУКТУРА И СОДЕРЖАНИЕ ПРАКТИЧЕСКОЙ ЧАСТИ 

КУРСА 

 

Лабораторные работы (72 час.) 

 

Лабораторная работа №1. Mathcad в математических расчетах (18 

час.). 

Задание 1. Вычислить: 

=100  10 |-10| = 10 10! = 3628800 sin(0)=0 cos()=-1 tg(-

/4)=-1 

ctg(100)= 5.671 ln(2)=0.693 log(0,1)=-1 
310−e = 1.001  log210= 
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Задание 2. Выполнить следующие операции с комплексными числами: 

 

Z := -3 + 2i     |Z| =       Re(Z) =       Im(Z) =        arg(Z) =      

Z =        5− =          2  Z =         Z1 := 1 + 2i     Z2 := 3 + 4i       

Z1 + Z2 =       Z1 - Z2 =       Z1 Z2 =        Z1/Z2 = 

 

Задание 3. Вычислить спецфункции: 

 

J0(11)= -0.171190300407196 I0(11)= 7288.48933982125  

Y1(11)= 0.163705537414943 I1(11)= 6948.85865981216   

js(5,11)= -0.095892036715012 ys(5,11)= 0.017464525161312 

Yn(10,11)= -0.198324030850285 Kn(10,11)= 0.00039525556856775 

 

Задание 4. Ввести ранжированные переменные и вывести 

результат: 

 

i := 1 .. 10  j := 1,2 .. 10   k := 1,-2 .. -10  n := -1,-2 .. -10 

m=0, 0,1 .. 1 

Выполнить следующие операции: 

i := 1 .. 10       
i

i =           ( ) +

i

i 1 =         +
4.0

0
2 )2lg( dxxx =   




2.1

8.0 2)2(sin

2ctg
dx

x

x
=         x := 2           

5x
dx

d
 = 

 

Задание 5. Ввести матрицы и проделать операции: 

 

M

1
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max(M)=8 min(M)=-8 

 

Вычислить число строк и колонок матрицы М. Извлечь из матрицы М 

второй столбец и третью строку. 

 

Задание 6. Ввести матрицы и проделать операции: 

 

M
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length(V)=3   last(V)=2   max(V)=10 

min(V)=4   max(M)=51   min(M)=0 

cols(M)=5   rows(M)=3   rank(M)=3 

mean(M)=10,067  sort(V)=   csort(M,2)= 

rsort(M,0)= 

 

Задание 7. Записать в файл значения матриц М и V, введенных 

ранее: 

 

WRITEPRN(“имя_файла1.prn”):=V 

 WRITEPRN(“имя_файла2.prn”):=M 

Vnew:=READPRN(“имя_файла1.prn”) 

 Mnew:=READPRN(“имя_файла2.prn”) 

Vnew=      Mnew= 



 

Лабораторная работа №2. Построение графиков и символьные 

вычисления в пакете Mathcad (18 час). 

Указания по выполнению работы 

Для вставки графики используется меню Вставить, подменю Графика.  

Его команды: 

График X-Y – строит 2-мерный график в декартовых координатах; 

Полярный график - строит 2-мерный график в полярных координатах. 

Для этих графиков аргументы X,Y должны быть векторами или 

диапазонами. 

Для вывода нескольких графиков на одном чертеже достаточно в поле 

ввода функции нажать запятую и ввести имя второго вектора. 

Для управления графиком нужно выполнить на нем двойной щелчок 

мышью и настроить график в окне Formatting: 

Закладка Оси X-Y – управление осями; 

Закладка Метки (Traces) – управление цветами и стилями линий; 

Закладка Метки (Labels) – заголовки графика и осей; 

Закладка По умолчанию (Defaults) – установка оформления по 

умолчанию. 

Для вывода трехмерных графиков и диаграмм используются остальные 

пункты меню Вставить, подменю Графика: 

График с поверхностями (Surface Plot) – график поверхности; 

Контурный график (Contour Plot) – линии уровня; 

3D  График рассеяния (3D Scatter Plot) – точечная диаграмма; 

3D  Полосы (3D Bar Plot) – столбцовая диаграмма; 

График с векторным полем (Vector Field Plot) – векторное поле; 

Мастер графика (3D Plot Wizard) – мастер создания 3-мерных 

диаграмм. 

Данными для всех этих графиков является матрица. 

Для настройки выполнить двойной щелчок на диаграмме, вращать 



диаграмму можно при нажатой левой клавише мыши. 

 

Задания на выполнение 

Задание 1. 

1. Построить в декартовой системе координат график двух 

функций: f(x)=2x+3sin(x) и ее производной g(x)=
dx

xdf )(
на отрезке [0;10] с 

шагом по x=0,05. 

2. Определить по графику координаты точки пересечения графиков 

f(x) и g(x).  

3. Изменить форматирование графиков: добавить линии сетки, 

подписи графика и осей, маркеры, цвет и начертание графиков. 

 

Задание 2. 

1. Построить в декартовой системе координат график функции 

f(t(x))= ))(log()( xte xt +  на отрезке [10;100] с шагом по x=0,5, где t(x)= x . 

2. Изменить форматирование графика: добавить линии сетки, 

подписи графика и осей, маркеры, цвет и начертание графиков. 

 

Задание 3. 

1. Построить в полярной системе координат график функций 

f(x)=sin(0,1·x) и g(y)=cos(0,5·y) на отрезке [0;2π] с шагом по x и y равным 

0,05π. 

2. Определить по графику координаты точки пересечения графиков 

f(x) и g(y).  

3. Изменить форматирование графика: добавить линии сетки, 

подписи графика и осей, маркеры, цвет и начертание графиков. 

 

Задание 4. 

1. Построить в полярной системе координат график функций 



f(x)=sin(5·x) и g(y)=sin(5·y) на отрезке [0;2π] с шагом по x=0,01π, по y=0,18π. 

2. Изменить форматирование графика: добавить линии сетки, 

подписи графика и осей, маркеры, цвет и начертание графиков. 

 

Задание 5. 

1. Построить в полярной системе координат график функций x(y), 

где x(t)=sin(2t), y(t)=cos(2t), на отрезке [0;2π] с шагом по t=0,01π. 

2. Изменить форматирование графика: добавить линии сетки, 

подписи графика и осей, маркеры, цвет и начертание графиков. 

 

Задание 6. 

1. Создать функцию 2-х переменных X(t,α):=t⋅cos(α)⋅sin(α). Задать ti 

принимающую значения от –5 до 5 с шагом 0,25 (i изменяется от 0 до 40), αj 

принимающая значения от 0 до 2π с шагом π/20 (j изменяется от 0 до 40). 

Определить матрицу Mi,j:=X(ti,αj). Вывести значение матрицы М. Отобразить 

матрицу М в виде поверхности и в виде линий уровня.  

2. Используя возможность формата графиков изменить поворот 

вокруг вертикали, горизонтали, изменить цвет и тип линии поверхности, 

параметры осей, заголовок графика. 

Задание 7. 

1. Построить трехмерный график функции f(x,y)=sin(x2+y2), где x 

принадлежит интервалу [-1.5,1.5], y – интервалу [-1.5,1.5], шаг по x и y равен 

0,1. 

2. Используя возможность формата графиков изменить поворот 

вокруг вертикали, горизонтали, изменить цвет и тип линии поверхности, 

параметры осей, заголовок графика. 

 

Задание 8. 

1. Построить трехмерный график типа 3D Bar Plot для матрицы M, 

заданной вручную. 



2. Используя возможность формата графиков изменить поворот 

вокруг вертикали, горизонтали, изменить цвет и тип линии поверхности, 

параметры осей, заголовок графика. 

M
0.91 0.07 0.84

0.99 0.53 0.58

0.74 0.86 0.24

=

 

 

Задание 9. 

1. Построить параметрический трехмерный график кривой, где 

координаты по осям определяются как: x(n)=cos(6πn),  y(n)= sin(6πn), z(n)= 

6πn, где n изменяется от 0 до 1 с шагом 0,01. 

2. Используя возможность формата графиков изменить поворот 

вокруг вертикали, горизонтали, изменить цвет и тип линии поверхности, 

параметры осей, заголовок графика. 

 

Задание 10. 

1. Построить параметрический трехмерный график поверхности, 

где координаты по осям определяются как: x(φ,γ)=sin(φ)cos(γ),  

y(φ,γ)=sin(φ)sin(γ), z(φ,γ)=cos(φ), γ изменяется от 0 до π с шагом 0,05π, φ 

изменяется от 0 до 2π с шагом 0,1π.  

2. Используя возможность формата графиков изменить поворот 

вокруг вертикали, горизонтали, изменить цвет и тип линии поверхности, 

параметры осей, заголовок графика. 

 

Задание 11. 

1. Построить параметрический трехмерный график поверхности, 

где x(φ,γ)=sin(φ)cos(γ),  y(φ,γ)=sin(φ)sin(γ), z(φ,γ)=cos(φ), γ изменяется от 0 до 

0,75π с шагом 0,05π, φ изменяется от 0 до 2π с шагом 0,1π. 

2. Используя возможность формата графиков изменить поворот 

вокруг вертикали, горизонтали, изменить цвет и тип линии поверхности, 

параметры осей, заголовок графика. 



 

Задание 12. 

1. Используя переменную FRAME и команду View/Animate, создать 

анимацию функций 

 

Переменные Функции FRAME Тип графика 

x:=0,0,1..30 f(x):=x+FRAME от 0 до 20 Polar Plot 

 

i:=0..20 

j:=0..20 

 

f(x,y):=sin(x2+y2+FRAME) 

x(i):=-1.5+0.15i 

y(j):=-1.5+0.15j 

от 0 до 50 Surface Plot 

 

 

Задание 13. 

Выполнить символьное преобразование (Symbolic Evalution) 

математических выражений в командном режиме с помощью команд меню 

Symbolics и с помощью оператора “→”: 

Исходные данные Результат операции 

  

cos(π)+ sin(π) -1 

x
x
2d

d
 

2·x 

a−

0

xx
3

5+( )



d  -0.25·a4+5·a 

1−  i 

 

Задание 14. 

Выполнить упрощение математических выражений в командном 

режиме с помощью команд меню Symbolics и с помощью оператора “→”: 

 

Исходные данные Результат операции 

  

10

a

1

a
2

+
3

a
3

+
6

a
4

+
5

a
5

−

 

10 a
4

 a
3

+ 3 a
2

+ 6 a 5−+

a
5

 

tan x( )
2

cot x( )
2

+  
2 cos x( )

4
 1 2 cos x( )

2
−+( )−

cos x( )
2

1−( ) cos x( )
2

+   



sin x( )
2

cos x( )
2

+
 

1 

x x

sin x( )

5

d

d









d

d
 

1−

5
sin x( )

 

a

b

y

0



xcos x y−( )




d




d

 
2−( ) cos b( ) 2 cos a( )+  

k

x
2

1+( )
 

x
2

1+( ) k  

i

x

x
5

6−


 

x

x
5

6−









i

 
  

 

Задание 15. 

Выполнить разложение по степеням математических выражений в 

командном режиме с помощью команд меню Symbolics и с помощью 

оператора “→”: 

 

Исходные данные Результат операции 

  

sin x y−( ) 
 

sin x( ) cos y( ) cos x( ) sin y( )−  
 

x y−( )
2
 x

2
2 x y− y

2
+  

  

 

Задание 16. 

Выполнить разложение на множители математических выражений в 

командном режиме с помощью команд меню Symbolics и с помощью 

оператора “→”: 

Исходные данные Результат операции 

  

x
2

2 x y− y
2

+  sin x y−( ) 

2 x
3

 12 x
2

− 22 x+ 12−  2 x 1−( ) x 2−( ) x 3−( )  

n

x n+( )
 

1

2
n n 2 x 1−+( )

 
  

 

Задание 17. 



Выполнить разложение по подвыражениям математических выражений 

в командном режиме с помощью команд меню Symbolics и с помощью 

оператора “→”: 

 

Исходные данные Результат операции 

  

x i−( ) x j−( )
 x

2
i−( ) j−[ ] x+ i j+  

  

 

Задание 18. 

Выполнить вычисление коэффициентов полинома математических 

выражений в командном режиме с помощью команд меню Symbolics и с 

помощью оператора “→”: 

Исходные данные Результат операции 

  

x
4

5 x
3

− 25 x
2

+ 15 x− 50+  

50

15−

25

5−

1















 

Задание 19. 

Решить уравнение в командном режиме с помощью команд меню 

Symbolics и с помощью оператора “→”: 

Исходные данные Результат операции 

  

b x
2

 c x+ d+  

1

2 b
c−( ) c

2
4 b d−( )

1

2

+











1

2 b
c−( ) c

2
4 b d−( )

1

2

−





























 

Задание 20. 

Выполнить подстановку в математических выражениях в командном 

режиме с помощью команд меню Symbolics и с помощью оператора “→”: 

Исходные данные Результат операции 



  

Исходное выражение

sin a( )

a
tan a

2( )

 

 

Выражение для подстановки (x+5) 

sin x 5+( )

x 5+
tan x 5+( )

2 

 
 

Задание 21. 

Выполнить разложение на элементарные дроби математических 

выражений в командном режиме с помощью команд меню Symbolics и с 

помощью оператора “→”: 

Исходные данные Результат операции 

  
x 3+

x
3

125−  

8

75 x 5−( )

1

75

5 8 x+

x
2

5 x+ 25+

−

 
 

Задание 22. 

Выполнить матричные операции в командном режиме с помощью 

команд меню Symbolics и с помощью оператора “→”: 

 

Исходные данные Матричная операция Результат операции 

   

x

y

x

y







  

Транспонировать x

x

y

y







 

a

c

b

d







  

Обращение матрицы 1

a d b c−

d

c−

b−

a










 

a

c

b

d







  

Вычислить 

определитель a d b c−  

 

Задание 23. 

Выполнить разложение в ряд Тейлора математических выражений в 

командном режиме с помощью команд меню Symbolics и с помощью 

оператора “→”: 

Исходные данные Число членов ряда Результат операции 

x
2
 6 x

2
 

sin x( ) 
10 1 x

1

6
x
3

−
1

120
x
5


1

5040
x
7

−+
1

362880
x
9

+
 

 



Задание 24. 

Выполнить прямые и обратные преобразования математических 

выражений в командном режиме с помощью команд меню Symbolics и с 

помощью оператора “→”: 

Исходные данные Вид преобразования Результат операции 

   

exp a− t( ) 
Преобразование 

Лапласа 

1

s a+  

sin b t( ) 
Преобразование 

Лапласа 

b

s
2

b
2

+  

1

2
exp

t
2

−

8











 

Преобразование 

Фурье 
1

2
8

1

2


1

2
e

2−( ) 
2




 

a t  
Преобразование 

Фурье 
2 1i a   1 ( )  

N Z-преобразование 
z

z 1−( )
2
 

sin a n( ) 

 

Z-преобразование 

 

 

sin a( )
z

2−( ) z cos a( ) z
2

+ 1+



 

 

Лабораторная работа №3. Основы MatLab (18 час), с использованием 

метода активного обучения – диспут на занятии 

Указания по выполнению: 

Перед выполнением заданий необходимо включить автоматическое 

сохранение дневника сессии для сохранения всех введенных команд, что 

полезно для последующего оформления отчета по лабораторной работе. Для 

сохранения дневника сессии используется команда 

diary filename , 

которая ведет запись на диск всех команд в строках ввода и 

полученных результатов в виде текстового файла с указанным именем 

filename (например, diary ‘c:\temp\myfile.txt’). 

После вывода графиков их полезно также сохранить в файл с помощью 

команды Save as в меню File. 

Вводимые команды полезно пояснять комментариями, которые 



вводятся после знака % , например: 

%поэлементное умножение вектора v на матрицу V. 

v.*V;     

Перед выполнением лабораторной работы каждому студенту 

преподавателем присваивается номер варианта для выполнения заданий. 

Этот вариант необходимо указать на титульном листе отчета по 

лабораторной работе. 

 

Задания на выполнение: 

Задача 1. Изучить интерфейс MatLab. Выполнить в режиме 

калькулятора следующие действия: 

− Выполнить над операндами 1 и 2 операцию 1. 

− Выполнить над результатом и операндом 1 операцию 2. 

− Выполнить над результатом и операндом 2 операцию 3. 

− Возвести почленно операнд 1 в степень 3. 

Варианты заданий 

№ Операнд 1 Операнд 

2 

Оператор 

1 

Оператор 2 Оператор 

3 

1  V=[ 12 34 61 45 11 ]  v = 34  *  ./  + 

2  V=[ 80 67 34 11 45 ]  v = 43  /  .*  - 

3  V=[ 19 77 45 11 67 ]  v = -5  +  .\  / 

4  V=[ 11 98 67 45 22 ]  v = 7  -  .*  / 

5 V=[ 67 34 67 45 56 ]  v = -12  +  .\  * 

6 V=[ 18 36 45 45 4 ]  v = 10  /  ./  - 

7 V=[ 55 43 8 45 23 ]  v = 44  /  .*  / 

8  V=[ 32 28 55 45 34 ]  v = 87  *  -  / 

9  V=[ 14 34 33 45 15 ]  v = 78  *  +  + 

10  V=[ 15 23 17 45 9 ]  v = -22  /  -  * 

11  V=[ 10 34 10 45 7 ]  v = -14 *  - * 

12  V=[ 95 56 5 45 54 ]  v = 99  +  ./  + 

13  V=[ 18 90 35 45 46 ]  v = 32  *  .*  - 

14  V=[ 24 34 87 45 88 ]  v = -43  /  .*  / 

15  V=[ 14 41 90 45 77 ] v = 55  /  +  + 

 

Задача 2. 



− Ввести текст в виде комментария, как заглавие программы. 

− Ввести исходные данные. 

− Задать изменение аргумента. 

− Вычислить значения функций 1 и 2 для аргумента в заданном 

интервале (начальное значение аргумента a, конечное значение аргумента b, 

шаг изменения аргумента h). 

− Вывести графики функций одновременно на одном графике в 

декартовых координатах. Для разных графиков использовать разный тип 

линий. 

Задача 3. 

− Вывести графики функций в двух подокнах на одном графике. 

Графики сделать в столбиковом формате. 

№  Функция 1  Функция 2  a  b  h 

1  y = sin(x)  z= exp(x+3)/5000 – 1  -2π  2π  π/20 

2  y = cos(x)  z = 0.00025e3-x - 0.6  -2π  2π  π/20 

3  y = |tg(x)| + 0.1  z = (1+x)6  -2π  2π  π/20 

4  y = (x2-1)/15 z = 1+sin(x)  -2π  2π  π/20 

5  y = (x3-2)/15  z = 5cos(x)  -2π  2π  π/20 

6  y = x2 – 10 z = 0.025exp(-1.2x)  -5  5  1 

7  y = 3sin(x)  z=0.015x3  -5  5  1 

8  y = 4sin(x)  z = 0.05x2  1  10  1 

9  y = 6sin(x)  z = 0.01x3  -10  10  1 

10  y = 2+cos(x)  z = - 0.05(x2 + 

10cos(x))  

-8  8  1 

11  y = sin2(x/3)  z = 0.01(x2 - 40sin(x))  -8  8  1 

12  y = cos3(x)  z = sin(x) + sin(2x)  -π  0  π/8 

13  y = 0.5x + cos2(x)  z = sin2(x) + cos(x)  -π  0  π/8 

14  y = sin(x) + 

cos2(2x)  

z = x(0.5 + x)exp(0.1x)  -π  0  π/8 

15  

 

y = |sin(x)|exp(x/2)  z = 5x – x1.5+sin(x)  0  5  0.5 

 

Задача 4. Двумерная функция и объемные графики в своих окнах. 

 

Варианты заданий 

№  Функция  Пределы изменения x  Пределы изменения 

y 



1  z=sin(x)cos(y)  От -2π до 2π  от -2π до 2π 

2  z=sin(x/2)cos(y)  От -2π до 2π  от -2π до 2π 

3  z=sin(2x)cos(y)  От -2π до 2π  от -2π до 2π 

4  z = sin(x)cos(y/2)  От -2π до 2π  от -2π до 2π 

5  z = sin(x/2)cos(2y)  От -2π до 2π  от -2π до 2π 

6  z = sin(2x)cos(2y)  От -2π до 2π  от -2π до 2π 

7  z = (1+sin(x)/x)(sin(y)/y)  От -2π до 2π  от -2π до 2π 

8  z = (sin(x)/x)cos(y)  От -2π до 2π  от -2π до 2π 

9  z = (sin(x)/x)|cos(y)|  От -2π до 2π  от -2π до 2π 

10  z = (sin(x)/x)y  От -2π до 2π  от -2π до 2π 

11  z = (sin(x)/x)|y|  От -2π до 2π  от -2π до 2π 

12  z = (sin(x)/x)sin(y)  От -2π до 2π  от -2π до 2π 

13  z = (sin(x)/x)|sin(y)|  От -2π до 2π  от -2π до 2π 

14  z = (sin(x)/x)(1-y)  От -2π до 2π  от -2π до 2π 

15  z = (sin(x)/x)|y+0.5|  От -2π до 2π  от -2π до 2π 

 

Задача 5. Двумерная функция и объемные графики в подокнах общего 

окна. 

Проделать операции аналогично заданию 4, но все графики вывести в 

одном окне, каждый в своем подокне. 

Варианты заданий 

№  f1(x)- полином 3-ей степени с 

коэффициентами 

a3, a2, a1, a0, 

F2(x) Пределы 

изменения х, с 

шагом 0.1 

1  0, -1, 4, -1 0.2·ex-20 от -4 до 6 

2  0, 2, -2, -15 40·|cos(x)| от -6 до 6 

3  0, 1, 4, -1 10·ln(x+5.5) от -6 до 4 

4  0, 9, -8, -70 100·|sin(x)| от -4 до 6 

5  0, -4, 4, 50 70·cos(x) от -6 до 6 

6  0.1, -5, 4, 40 60·e|0.1·x|-100 от -1 до 1 

7  0.2, -3, 2, 30 20·sin(2x) от -4 до 6 

8  0.3, -6, 1, 50 E|x|·sin(2x) от -4 до 6 

9  0.4, -9, 1, 70 E|x|·cos(3x) от -4 до 6 

10  0.5, -7, 5, 60 -60·|cos(x)| от -4 до 6 

11  -0.1, -4, 9, 60 15·log(x+5) от -4 до 6 

12  -0.2, -6, -7, 55 -50·ln(x+5) от -6 до 6 

13  -0.3, -9, -8, 75 -100·|cos(x)| от -6 до 6 

14  -0.4, 7, 8, -75 100·sin(x/2) от -6 до 2 

15  -0.5, 1, 4, -1 40·cos(x/2) от -4 до 6 

 

Задача 6. Решение нелинейного уравнения. 



− Создать Mat-функцию для функции f1(x). 

− Создать файл программы. Ввести текст заглавия задачи, как 

комментарий. Ввести в него аргументы в заданных пределах. 

− Вывести y(x)=f1(x) в виде XY графика. По нему определить 

приближенно корни уравнения y(x)=0. Если корни на графике не 

просматриваются, то изменить пределы изменения аргумента и повторить 

операции. 

− Для каждого корня найти точное значение, используя функцию fzero. 

− Сформировать строку с результатами и вывести ее в заголовок окна 

графика. 

Задача 7. Решение системы из двух нелинейных уравнений. 

− Создать Mat-функции для функций f2(x) и f3(x) = f1(x) - f2(x). 

− Создать файл программы. Ввести текст заглавия задачи, как 

комментарий. Ввести в него аргументы в заданных пределах. 

− Вывести f1(x) и f2(x) в виде XY графиков. По нему определить 

приближенно корни системы уравнений, как координаты точек пересечения 

графиков f1(x) и f2(x).Если корни на графике не просматриваются, то 

изменить пределы изменения аргумента и повторить операции. 

− Для каждого корня найти точное значение, используя функцию fzero 

к переменной f3(x). 

− Сформировать строку с результатами и вывести ее в заголовок окна 

графика. 

 

Лабораторная работа №4. Инструментальная система графического 

программирования LabView (18 час), с использованием метода активного 

обучения – диспут на занятии 

Задания на выполнение: 

Задание 1. Создание виртуального прибора «Преобразование °C в 

°F» 

Ниже приведена последовательность действий для создания VI, 



который будет преобразовывать значение температуры из градусов Цельсия 

в градусы Фаренгейта. 

1. Лицевая панель 

Выберите пункт главного меню File » New » VI, чтобы открыть новую 

лицевую панель. 

2. Выбрать пункт главного меню Window » Tile Left and Right для 

вывода на экран рядом друг с другом лицевой панели и блок-диаграммы.  

 

3. Создайте цифровой элемент управления. Он будет использован 

для ввода значений температуры в °С: 

a) Выберите цифровой элемент управления в разделе палитры 

Элементов в подразделе Controls » Numeric (Числовые элементы). Для 

вывода на экран палитры Controls (Элементов) следует щелкнуть правой 

кнопкой мыши по рабочему пространству лицевой панели. 

b) Поместите цифровой элемент управления на лицевую панель . 

c) В поле собственной метки элемента управления напечатайте «Град 

С» и щелкните мышью в свободном пространстве лицевой панели или 

нажмите кнопку Enter, показанную слева, на инструментальной панели. Если 

сразу после создания элемента не присвоить имя его собственной метке, то 

LabVIEW присвоит имя, заданное по умолчанию. Собственная метка в любое 

время доступна для редактирования, оно производится с помощью 

инструмента ВВОД ТЕКСТА . 

4. Создайте цифровой элемент отображения данных. Он будет 

использован для отображения значений температуры в °F: 

a) Выберите цифровой элемент отображения в палитре Элементов в 

подразделе Controls » Numeric (Числовые элементы).  

b) Поместите элемент отображения данных на лицевую панель. 

c) В поле собственной метки элемента управления напечатайте 



«Град F» и щелкните мышью в свободном пространстве лицевой панели или 

нажмите кнопку Enter. 

На блок-диаграмме LabView создаст терминалы данных, 

соответствующие элементам управления и отображения. Терминалы данных 

представляют тип данных соответствующих элементов. Например, терминал 

данных DBL  представляет тип числовых данных двойной точности с 

плавающей запятой. 

Внимание. Терминалы данных, соответствующие элементам 

управления, имеют более широкий обводной контур по сравнению с 

терминалами данных, соответствующими элементам отображения. 

5. Перейдите на блок-диаграмму, выбрав пункты главного меню 

Window » Show Diagram. 

6. Выберите функцию Multiply (Умножение) из палитры 

Функций в разделе Functions » Numeric (Арифметические функции). 

Поместите ее на блок-диаграмму.  

7. Выберите функцию Add (Сложение) из палитры Функций в 

разделе Functions » Numeric (Арифметические функции). Поместите ее на 

блок-диаграмму.  

8. Выберите числовую константу  из палитры Функций в 

разделе Functions » Numeric (Арифметические функции).  

Поместите две числовые константы на блок-диаграмму. После 

размещения числовой константы на блок-диаграмме поле  ввода  ее значений 

подсвечивается и готово для редактирования. 

Одной константе присвойте значение 1,8, другой 32,0. 

Если значение в константу не введено сразу после ее размещения на 

блок-диаграмме, следует использовать инструмент ВВОД ТЕКСТА. 

9. Соедините объекты блок-диаграммы с помощью инструмента 

СОЕДИНЕНИЕ.  



10. Перейдите на лицевую панель, выбрав в главном меню пункт 

Window » Show Panel. 

11. Сохраните VI, он будет использоваться позднее: 

a) Выберите пункт главного меню File»Save. 

b) Укажите каталог для сохранения. 

c) В диалоговом окне введите имя «Преобразование С в F 

(начало).vi» 

d) Нажмите кнопку Save. 

12. Запустите VI и введите число в элемент управления: 

a) Для ввода числа в элемент управления следует использовать 

инструмент УПРАВЛЕНИЕ или инструмент ВВОД ТЕКСТА. 

b) Нажмите кнопку Run, чтобы запустить VI. 

c) Введите несколько разных значений температуры и 

перезапустите VI. 

d) Закройте VI, выбрав пункт главного меню File»Close. 

 

Создадим иконку и настроим соединительную панель для возможности 

использования VI в качестве подпрограммы VI «С в °F». 

13. Выберите пункт главного меню File»Open, укажите папку и 

выберите файл «Преобразование C в F (начало).vi». 

14. Если закрыты все VI, следует нажать кнопку Open VI (Открыть 

VI) в диалоговом окне LabView. Появится следующая лицевая панель: 

15. Щелкните правой кнопкой мыши по иконке VI и в контекстном 

меню выберите пункт Edit Icon (Редактирование иконки). Появится 

диалоговое окно редактора иконки Icon Editor.  

Дважды щелкните правой кнопкой мыши по инструменту ВЫБОР.  

Нажав кнопку <Delete>, очистите область редактирования иконки. 

 Дважды щелкните по инструменту ПРЯМОУГОЛЬНИК , чтобы 

обвести область редактирования границей выбранного цвета. 



Создайте следующую иконку: 

a) Введите текст инструментом ВВОД ТЕКСТА.  

b) Напечатайте «C» и «F». 

c) Для выбора размера шрифта дважды щелкните левой кнопкой 

мыши по инструменту ВВОД ТЕКСТА. 

d) Чтобы нарисовать стрелку, воспользуйтесь инструментом 

КАРАНДАШ.  

Внимание. Для рисования вертикальных, горизонтальных и 

диагональных линий требуется во время рисования нажать и удерживать 

клавишу <Shift>. 

e) Для передвижения текста и стрелки по полю редактирования 

иконки используйте инструмент ВЫБОР и стрелки на клавиатуре. 

f )  В разделе Copy from (Копировать) выберите B & W (черно-

белую) иконку и 256 Colors (256-цветный режим) для создания черно-белой 

иконки, которую LabVIEW использует в случае отсутствия цветного 

принтера. 

g)  В разделе Copy from (Копировать) выберите 16 Colors и 256 

Colors. 

h) После завершения редактирования иконки нажмите кнопку OK и 

закройте Icon Editor. Новая иконка появится в правом верхнем углу обеих 

панелей. 

 

16. Перейдите на лицевую панель, щелкните правой кнопкой мыши 

на иконке и выберите пункт Show Connector (Показать поля ввода/вывода 

данных) из контекстного меню. Количество отображаемых полей 

ввода/вывода данных соответствует количеству элементов на лицевой 

панели. Например, лицевая панель этого VI имеет два элемента «Град C» и 

«Град F» и LabVIEW выводит в соединительной панели два поля. 



17. Элементам управления и отображения данных назначьте 

соответственно поля ввода и вывода данных. 

a) В пункте главного меню Help (Помощь) выберите Show Context 

Help (контекстную подсказку) и выведите на экран окно Context Help 

(контекстной справки) для просмотра соединений. 

b) Щелкните левой кнопкой мышки на левом поле соединительной 

панели. Инструмент УПРАВЛЕНИЕ автоматически поменяется на 

инструмент СОЕДИНЕНИЕ, а выбранное поле окрасится в черный цвет. 

c) Щелкните левой кнопкой мыши по элементу «Град C». Левое 

поле станет оранжевым и выделится маркером. 

d) Щелкните курсором по свободному пространству. Маркер 

исчезнет, и поле окрасится в цвет данных типа соответствующего элемента 

управления. 

e) Щелкните левой кнопкой мыши по правому полю 

соединительной панели и элементу «Град F». Правое поле станет оранжевым. 

f) Щелкните курсором по свободному пространству. Оба поля 

останутся оранжевыми. 

g) Наведите курсор на область полей ввода/вывода данных. Окно 

Context Help (контекстной справки) покажет, что оба поля соответствуют 

типу данных двойной точности с плавающей запятой. 

9. Выберите пункт главного меню File » Save. Сохраните VI под 

именем «Преобразование C в F.vi». 

10. Выберите пункт главного меню File » Close. Закройте VI.  

 

Задание 2. Создание виртуального прибора, выполняющего 

математические действия. 

Необходимо создать виртуальный прибор (VI), выполняющий 

определенные математические действия над аргументами, согласно заданию. 

При этом необходимо реализовать контроль значения аргументов, чтобы в 

случае особых точек функции (таких как деление на ноль, неопределенность 



и пр.) выдавалось соответствующее сообщение. 

 

№  Математическое действие  

 

Особые точки  

1  y = 1/sin(x)  x=n*π, где n=0, ±1, ±2, ±3.. 

2  y = 1/sin(x)  x=n*π/2, где n=0, ±1, ±2, ±3.. 

3  y = 1/tg(x)  x=n*π/4, где n=0, ±1, ±2, ±3.. 

4  y = 1/(x2-1) x=±1 

5  z = Ошибка! Источник ссылки 

не найден./(y3-2)  

x<0, y=Ошибка! Источник ссылки 

не найден.  

6  z = 1/(x2 – y) x2 = y  

7  y = 1/(Ошибка! Источник 

ссылки не найден.-1) 

x<0, x=1 

8  z = 1/sin(Ошибка! Источник 

ссылки не найден.)  

y = 0,  x=n*π*y+1, где n=0, ±1, ±2, 

±3.. 

9  z =Ошибка! Источник ссылки 

не найден. 

одновременное выполнение 

Ошибка! Источник ссылки не 

найден. и (x=n*π, где n=0, ±1, ±2, 

±3..) 

10  z =Ошибка! Источник ссылки 

не найден. 

одновременное выполнение x= -1 и 

y≤10 

11  y = sin2(1/x)  x=0, x=1/(n*π), где n= ±1, ±2, ±3.. 

12  y = sin(x) + sin(3x) x=n*π, x=n*π/3, где n=0, ±1, ±2, ±3.. 

13  z = (x+y)/(x*y*(x+y)) x=0 или y=0 или (x+y)=0 

14  y =Ошибка! Источник ссылки 

не найден. 

x<0, Ошибка! Источник ссылки не 

найден.=n*π, где n=0, ±1, ±2, ±3.. 

15  y = |sin(x)|/exp(Ошибка! 

Источник ссылки не найден.)  

x<0 

 

Задание 3. Экспресс - виртуальные приборы 

Экспресс-VI — узлы функций, которые можно настраивать с помощью 

диалогового окна. Они используются для выполнения стандартных 

измерений при минимальных соединениях. 

Создать схему из узлов экспресс-VI: генератора с регулируемыми 

параметрами, блока преобразований сигнала и инструмента отображения 

«Waveform Graph». 

 



№  Генератор 

 

Блок преобразований Регулируемые 

параметры 

1  Генератор прямоугольных 

импульсов 

Scaling and mapping в режиме 

normalize 

Амплитуда и частота 

сигнала 

2  Генератор треугольных 

импульсов 

Scaling and mapping в режиме 

линейного усиления с 

коэффициентом m = 10 

Амплитуда и частота 

сигнала 

3  Генератор синусоидального 

сигнала 

Extract Portion of Signal Амплитуда и частота 

сигнала, Samples 

4  Генератор прямоугольных 

импульсов с белым шумом 

Spectral Measurements Амплитуда шума и 

частота сигнала 

5  Генератор треугольных 

импульсов с белым шумом 

Extract Portion of Signal Амплитуда шума и 

фаза сигнала, Samples 

6  Генератор синусоидального 

сигнала с белым шумом 

Extract Portion of Signal Амплитуда шума и 

амплитуда сигнала, 

Samples 

7  Генератор прямоугольных 

импульсов с гаусовским 

белым шумом 

Filter в режиме Lawpass Амплитуда шума и 

частота сигнала 

8  Генератор треугольных 

импульсов с гаусовским 

белым шумом 

Filter в режиме Lawpass Амплитуда шума и 

частота сигнала 

9  Генератор синусоидального 

сигнала с гаусовским 

белым шумом 

Scaling and mapping в режиме 

линейного усиления с 

коэффициентом m = 10 

Амплитуда шума и 

фаза сигнала 

10  Генератор прямоугольных 

импульсов с Inverse F 

шумом 

Spectral Measurements Амплитуда шума и 

амплитуда сигнала 

11  Генератор треугольных 

импульсов с Inverse F 

шумом 

Filter в режиме Lawpass Амплитуда шума и 

частота сигнала 

12  Генератор синусоидального 

сигнала с гамма шумом 

Spectral Measurements Амплитуда шума и 

частота сигнала 

13  Генератор пилообразных 

импульсов с Inverse F 

шумом 

Filter в режиме Bandpass Амплитуда шума и 

фаза сигнала, Lower-

Cutoff, Upper Cut-off 

14  Генератор пилообразных 

импульсов с гаусовским 

белым шумом 

Filter в режиме Bandpass Амплитуда шума и 

амплитуда сигнала, 

Lower-Cutoff, Upper 

Cut-off 

15  Генератор 

пилообразных 

импульсов с белым 

шумом 

Filter в режиме Bandpass Амплитуда шума и 

частота сигнала, 

Lower-Cutoff, 

Upper Cut-off 

 

Задание 4. Расчет значения функции на заданном интервале 

Создать виртуальный прибор (VI), позволяющий рассчитывать 

значение функции f(x) на заданном интервале с заданным шагом и 



отображать значения функции на графике.  

Для построения графика использовать функцию, созданную в задании 

2, в зависимости от аргумента x. 

VI должен поддерживать работу в двух режимах. В первом режиме 

должна быть предусмотрена возможность строить график функции на 

заданном интервале и сохранять его в файл в формате LabView Waveform. Во 

втором режиме необходимо организовать чтение ранее записанных данных 

из файла, отображение их на графике и конвертацию данных в обычный 

текстовый файл. 

 

III. УЧЕБНО-МЕТОДИЧЕСКОЕ ОБЕСПЕЧЕНИЕ 

САМОСТОЯТЕЛЬНОЙ РАБОТЫ ОБУЧАЮЩИХСЯ 

 

Учебно-методическое обеспечение самостоятельной работы 

обучающихся по дисциплине «Прикладное программирование» представлено 

в Приложении 1 и включает в себя: 

- план-график выполнения самостоятельной работы по дисциплине, в 

том числе примерные нормы времени на выполнение по каждому заданию; 

- характеристика заданий для самостоятельной работы обучающихся и 

методические рекомендации по их выполнению; 

- требования к представлению и оформлению результатов 

самостоятельной работы; 

- критерии оценки выполнения самостоятельной работы. 

 

IV. КОНТРОЛЬ ДОСТИЖЕНИЯ ЦЕЛЕЙ КУРСА 

 

№ 

п/п 

Контролируемые 

модули/ разделы 

/ темы 

дисциплины 

 

Коды и этапы формирования 

компетенций  

Оценочные средства - 

наименование 

текущий 

контроль 

промежуто

чная 

аттестация 



1 Персональный 

компьютер  

Способность 

осуществлять поиск, 

хранение, обработку и 

анализ информации из 

различных источников и 

баз данных, 

представлять ее в 

требуемом формате с 

использованием 

информационных, 

компьютерных и 

сетевых технологий 

(ОПК-2) 

Знает Устный 

опрос (УО-

1) 

Вопрос № 

1-5 в 

Приложени

и 2 

Умеет Устный 

опрос (УО-

1) 

Вопрос № 

6-10 в 

Приложени

и 2 

Владеет Устный 

опрос (УО-

1) 

Вопрос № 

11-15 в 

Приложени

и 2 

2 Персональный 

компьютер  

Способность владеть 

методами 

информационных 

технологий, соблюдать 

основные требования 

информационной 

безопасности, в том 

числе защиты 

государственной тайны 

(ОПК-9) 

Знает Устный 

опрос (УО-

1) 

Вопрос № 

16-20 в 

Приложени

и 2 

Умеет Устный 

опрос (УО-

1) 

Вопрос № 

21-25 в 

Приложени

и 2 

Владеет Устный 

опрос (УО-

1) 

Вопрос № 

26-30 в 

Приложени

и 2 

3 Математический 

программный 

пакет Mathcad 

Готовность к 

математическому 

моделированию 

процессов и объектов 

приборостроения и их 

исследованию на базе 

стандартных пакетов 

автоматизированного 

проектирования и 

самостоятельно 

разработанных 

программных продуктов 

(ПК-2) 

Знает Устный 

опрос (УО-

1) 

Вопрос № 

31-35 в 

Приложени

и 2 

Умеет Устный 

опрос (УО-

1) 

Вопрос № 

35-40 в 

Приложени

и 2 



Владеет Устный 

опрос (УО-

1) 

Вопрос № 

41-45 в 

Приложени

и 2 

4 Математический 

программный 

пакет Matlab 

Готовность к 

математическому 

моделированию 

процессов и объектов 

приборостроения и их 

исследованию на базе 

стандартных пакетов 

автоматизированного 

проектирования и 

самостоятельно 

разработанных 

программных продуктов 

(ПК-2) 

Знает Устный 

опрос (УО-

1) 

Вопрос № 

46- 50 в 

Приложени

и 2 

Умеет Устный 

опрос (УО-

1) 

Вопрос № 

51-55 в 

Приложени

и 2 

Владеет Устный 

опрос (УО-

1) 

Вопрос № 

56-60 в 

Приложени

и 2 

5 Программный 

пакет LabView 

Способность 

использовать 

современные 

программные средства 

подготовки 

конструкторско-

технологической 

документации (ОПК-7) 

Знает Устный 

опрос (УО-

1) 

Вопрос № 

61- 65 в 

Приложени

и 2 

Умеет Устный 

опрос (УО-

1) 

Вопрос № 

66-70 в 

Приложени

и 2 

Владеет Устный 

опрос (УО-

1) 

Вопрос № 

71-72 в 

Приложени

и 2 

 

Типовые контрольные задания, методические материалы, 

определяющие процедуры оценивания знаний, умений и навыков и (или) 

опыта деятельности, а также критерии и показатели, необходимые для 

оценки знаний, умений, навыков и характеризующие этапы формирования 

компетенций в процессе освоения образовательной программы, 

представлены в Приложении 2. 

 



V. СПИСОК УЧЕБНОЙ ЛИТЕРАТУРЫ И ИНФОРМАЦИОННО-

МЕТОДИЧЕСКОЕ ОБЕСПЕЧЕНИЕ ДИСЦИПЛИНЫ 

Основная литература 

 

1. Численные методы и программирование: Учебное пособие / В.Д. 

Колдаев; Под ред. Л.Г. Гагариной. - М.: ИД ФОРУМ: НИЦ Инфра-М, 2013. - 

336 с. Режим доступа:  http://znanium.com/catalog.php?bookinfo=370603  

2. Архитектура ЭВМ: Учебное пособие / В.Д. Колдаев, С.А. Лупин. 

- М.: ИД ФОРУМ: НИЦ Инфра-М, 2013. - 384 с. Режим доступа:  

http://znanium.com/catalog.php?bookinfo=375092  

3. Долгов, А. И. Алгоритмизация прикладных задач [Электронный 

ресурс] : Уч. пособ / А. И. Долгов. - М. : Флинта, 2011. - 136 с. Режим 

доступа:  http://znanium.com/catalog.php?bookinfo=406093  

4. Алексеев, Г.В. Компьютерные технологии при проектировании и 

эксплуатации технологического оборудования [Электронный ресурс] / 

Алексеев Г.В., Бриденко И.И., Головацкий В.А.,Верболоз Е.И.. - Томск: 

ТУСУР (Томский государственный университет систем управления и 

радиоэлектроники), 2012. - 256 с. Режим доступа:  

http://e.lanbook.com/books/element.php?pl1_id=4878  

5. Макаров, Е. Инженерные расчеты в Mathcad 15: Учебный курс. –

СПб.: Питер, 2011. – 400с. 

 

Дополнительная литература 

 

1. Чен К., Джиблин П., Ирвинг А. Matlab в математических 

исследованиях. - М.: Мир, 2001. - 346 с. 

2. Дьяконов В. MATLAB 6: учебный курс. - СПб.: Питер, 2001. — 

592 с.: ил. 

3. Ануфриев И. Е., Смирнов А. Б., Смирнова Е. Н. MATLAB 7. - 

СПб.: БХВ-Петербург, 2005. - 1104 с: ил. 

http://znanium.com/catalog.php?bookinfo=370603
http://znanium.com/catalog.php?bookinfo=370603
http://znanium.com/catalog.php?bookinfo=375092
http://znanium.com/catalog.php?bookinfo=375092
http://znanium.com/catalog.php?bookinfo=406093
http://znanium.com/catalog.php?bookinfo=406093
http://e.lanbook.com/books/element.php?pl1_id=4878
http://e.lanbook.com/books/element.php?pl1_id=4878


4. Дьяконов В. П. Mathcad 2001: специальный справочник. - СПб.: 

Питер, 2002. 

5. Ивановский Р. И. Компьютерные технологии в науке и 

образовании. Практика применения систем MathCAD Pro. - М.: Высш. шк., 

2003. 

6. Очков В.Ф. Mathcad для студентов и инженеров. М.: 

КомпьютерПресс, 1998. - 384 с.: ил. 

7. Дьяконов В.П. Mathcad 8 PRO в математике, физике и Internet.–

М.:Нолидж,2000.-512 с. 

8. Херхагер М., Партолль Х. Mathcad 2000: полное руководство: 

Пер. с нем. - К.: Изда-тельская группа BHV, 2000. 

 

Перечень ресурсов информационно-телекоммуникационной сети 

«Интернет» 

 

1. http://window.edu.ru/resource/901/23901 Евдокимов Ю.К., 

Насырова Р.Г., Байтуллин А.Ф. Виртуальная электронная лаборатория в 

инструментальной среде LabVIEW: Методические указания для лабораторно-

практических занятий студентов заочного отделения. - Казань: Изд-во КГТУ, 

2001. - 26 с. 

2. http://window.edu.ru/resource/983/23983 Построение 

измерительных каналов с применением среды графического 

программирования LabView: Методические указания к лабораторным 

работам / Сост.: В.В. Алексеев, Е.Г. Гридина, Б.Г. Комаров, П.Г. Королев, 

М.Ю. Обоишев, Н.И. Куракина. СПб.: Изд-во СПбГЭ 

3. http://window.edu.ru/resource/377/79377 Изучение операционного 

усилителя и схем на его основе с использованием виртуальных приборов 

Labview: Практикум / Сост.: Сдобняков В.В., Карзанов В.В., Белянина М.Г., 

Бовкун Л.С. - Нижний Новгород: Нижегородский госуниверситет, 2012. - 45 

с. 

http://window.edu.ru/resource/901/23901
http://window.edu.ru/resource/901/23901
http://window.edu.ru/resource/983/23983
http://window.edu.ru/resource/983/23983
http://window.edu.ru/resource/377/79377
http://window.edu.ru/resource/377/79377


 

Перечень информационных технологий и программного обеспечения 

 

Место расположения 

компьютерной техники, на 

котором установлено 

программное обеспечение, 

количество рабочих мест 

Перечень программного обеспечения 

Компьютерный класс 

кафедры приборостроения,  

Ауд. Е628, 

21 

− Microsoft Office Professional Plus 2016 – офисный 

пакет, включающий программное обеспечение для 

работы с различными типами документов; 

− 7Zip 9.20 - свободный файловый архиватор с высокой 

степенью сжатия данных; 

− ABBYY FineReader 11 - программа для оптического 

распознавания символов; 

− Elcut 6.3 Student - программа для проведения 

инженерного анализа и двумерного моделирования 

методом конечных элементов (МКЭ); 

− Adobe Acrobat XI Pro – пакет программ для создания и 

просмотра электронных публикаций в формате PDF; 

− AutoCAD Electrical 2015 Language Pack – English - 

трёхмерная система автоматизированного 

проектирования и черчения; 

− MATLAB R2016a - пакет прикладных программ для 

решения задач технических вычислений и одноимённый 

язык программирования, используемый в этом пакете 

 

Программное обеспечение:  

1. Mathcad 2001 или новее, 

2. Matlab 7 или новее, 

3. LabView 2012 или новее. 

 

VI. МЕТОДИЧЕСКИЕ УКАЗАНИЯ ПО ОСВОЕНИЮ ДИСЦИПЛИНЫ 

 

При выполнении лабораторных работ и курсовой работы 

преподаватель контролирует работу студентов, отвечает на возникающие 

вопросы, подсказывает ход решения. Если полученных в аудитории знаний 

окажется недостаточно, студент может самостоятельно повторно прочесть 

лекцию или соответствующее пособие. После выполнения задания студент 

защищает его преподавателю в назначенное время. 

 



VII. МАТЕРИАЛЬНО-ТЕХНИЧЕСКОЕ ОБЕСПЕЧЕНИЕ 

ДИСЦИПЛИНЫ 

Для проведения исследований, связанных с выполнением задания по 

дисциплине, а также для организации самостоятельной работы студентам 

доступно специализированные учебные аудитории кампуса ДВФУ, 

оснащенные компьютерной техникой, а также мультимедийной техникой, 

соответствующие действующим санитарным и противопожарным нормам, а 

также требованиям техники безопасности при проведении учебных и научно-

производственных работ  

 

Наименование 

оборудованных помещений и  

помещений для 

самостоятельной работы 

Перечень основного оборудования 

1 2 

Лаборатория 

Вычислительной техники 

кафедры приборостроения, 

ауд. Е 628 

Частотомер Ч3-54; Прибор С1-76; Комплект 

оборудования №1; Лабораторный комплект основ 

разработки инженерных приложений и систем сбора 

данных Nl USB-DAQ Bundle X-series; Учебно-

исследовательский комплекс модульных приборов Nl 

Modular Instruments Kit 

Компьютерный класс, 

Ауд. Е628 

Моноблок HP РгоОпе 400 All-in-One 19,5 (1600x900), 

Core i3-4150T, 4GB DDR3-1600 (1x4GB), 1TB HDD 7200 

SATA, DVD+/-RW,GigEth,Wi-Fi,ВТ,usb 

kbd/mse,Win7Pro (64-bit)+Win8.1Pro(64-bit),1-1-1 Wty   

Читальные залы Научной 

библиотеки ДВФУ с 

открытым доступом к фонду  

(корпус А - уровень 10) 

Моноблок HP РгоОпе 400 All-in-One 19,5 (1600x900), 

Core i3-4150T, 4GB DDR3-1600 (1x4GB), 1TB HDD 7200 

SATA, DVD+/-RW,GigEth,Wi-Fi,ВТ,usb 

kbd/mse,Win7Pro (64-bit)+Win8.1Pro(64-bit),1-1-1 Wty   

Скорость доступа в Интернет 500 Мбит/сек. 

Мультимедийная 

аудитория 

проектор 3-chip DLP, 10 600 ANSI-лм, WUXGA 1 

920х1 200 (16:10)  PT-DZ110XE Panasonic; экран 

316х500 см, 16:10 c эл. приводом; крепление настенно-

потолочное Elpro Large Electrol Projecta; 

профессиональная ЖК-панель 47", 500 Кд/м2, Full HD  

M4716CCBA LG; подсистема видеоисточников 

документ-камера CP355AF Avervision; подсистема 

видеокоммутации; подсистема аудиокоммутации и 

звукоусиления; подсистема интерактивного управления; 

беспроводные ЛВС обеспечены системой на базе точек 

доступа 802.11a/b/g/n 2x2 MIMO(2SS) 
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План-график выполнения самостоятельной работы по дисциплине 

№ 

п/п 

Дата/сроки 

выполнения 

Вид 

самостоятельной 

работы 

Примерные 

нормы 

времени на 

выполнение 

Форма контроля 

1 По графику 

аттестаций 

Подготовка к 

текущим 

аттестациям  

3 часа устный опрос 

2 По графику 

выполнения 

лабораторных 

работ 

Подготовка к 

защите 

лабораторных 

работ 

3 часа устный опрос 

3 По расписанию 

сессии 

Курсовая работа 40 часов защита курсовой 

работы 

4 После каждой 

лекции 

Повторение 

теоретического 

материала 

3 часа блиц-опрос 

5 До зачетной 

недели 3-го 

семестра 

Подготовка к 

зачету 

20 часов сдача зачета 

6 По графику 

экзаменов 

Подготовка к 

экзамену 

21 часов сдача экзамена 

 

Характеристика заданий для самостоятельной работы обучающихся и 

методические рекомендации по их выполнению 

 

Каждый студент получает индивидуальное задание, в котором 

указывается тема работы. 

Необходимо проработать теоретический материал по теме, составить 

алгоритм решения задачи.  

Решение задачи необходимо реализовать в Mathcad и Matlab. 



Результатом решения должны быть: текст программ, графики, таблицы, 

сравнение результатов, полученных разными методами, а также сравнение 

полученных результатов в Mathcad и Matlab. Необходимо сделать выводы по 

результатам работы, где в числе прочего отразить достоинства и недостатки 

пакетов Mathcad и Matlab для решения подобных задач. 

 

Требования к представлению и оформлению результатов 

самостоятельной работы 

 

Содержание работы излагается в пояснительной записке, где  в 

лаконичной форме должна быть раскрыта суть  выполняемой  работы. В ней 

должны быть следующие разделы:  введение, описание метода решения 

задачи,  расчетная часть, выводы и анализ полученных результатов, список  

использованной литературы, в приложении должен находиться листинг 

разработанных  программ. Листинг программ должен сопровождаться 

подробными комментариями, графики должны иметь название, подписи 

осей, линий. Таблицы должны иметь подписи, названия колонок, 

комментарии. Сокращенные названия должны быть расшифрованы, 

нумерация формул проводится справа в конце строки в круглых скобках – 

(1), ссылки на литературу - в квадратных скобках – [1].  

Оформление пояснительной  записки   выполняется в редакторе 

Microsoft Word (формат файла Word 2003 и старше), шрифт Times New 

Roman, размер шрифта – 14 pt, междустрочный интервал – одинарный. В 

редакторе устанавливается бумага формата А4 (210*297), поле сверху – 2 см, 

поле снизу – 2 см, поле слева – 3 см, поле справа – 2 см., переплет – 0. 

Нумерация страниц:  производится справа снизу, номер на первой странице 

не ставится. Текст обязательно выравнивается по ширине. 

Объем работы не менее 10 страниц машинописного текста. 

К защите необходимо представить пояснительную записку в бумажном 

и электронном варианте, а также разработанные программы в электронном 



варианте (формат программы: Mathcad – 2001 и старше, Matlab – 6.5 и 

старше). 

 

Критерии оценки выполнения самостоятельной работы 

 

1. 10-9 баллов выставляется студенту, если студент выполнил все 

пункты задания. Фактических ошибок, связанных с пониманием проблемы, 

нет; графически работа оформлена правильно. При защите студент отвечает 

на все вопросы преподавателя. 

2. 8-7 баллов: работа выполнена полностью; допущено одна-две 

ошибки в оформлении работы. При защите студент отвечает на все вопросы 

преподавателя. 

3. 7-6 балл: работа выполнена полностью; допущено не более 2 

ошибок при оформлении работы. При защите студент не отвечает на 1-2 

вопроса преподавателя. 

4. 6-5 баллов: работа выполнена; допущено три или более трех ошибок 

в оформлении работы. При защите студент не отвечает на 2-3 вопроса 

преподавателя. 
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Код и формулировка 

компетенции 

Этапы формирования компетенции 

ОПК-2  

Способность 

осуществлять поиск, 

хранение, обработку и 

анализ информации из 

различных 

источников и баз 

данных, представлять 

ее в требуемом 

формате с 

использованием 

информационных, 

компьютерных и 

сетевых технологий  

Знает 
Основные информационные, компьютерные и 

сетевые технологии 

Умеет 

использовать компьютерную технику для поиска, 

хранения, обработки и анализа информации из 

различных источников и баз данных 

Владеет 
Навыками анализа поставленной задачи 

исследований в области приборостроения 

ОПК-7  

Способность 

использовать 

современные 

программные 

средства подготовки 

конструкторско-

технологической 

документации  

Знает основные программные средства подготовки 

конструкторско-технологической документации 

Умеет использовать современные программные средства 

подготовки конструкторско-технологической 

документации 

Владеет навыками работы с программными средствами 

подготовки конструкторско-технологической 

документации 

ОПК-9  

Способность владеть 

методами 

информационных 

технологий, 

соблюдать основные 

требования 

информационной 

безопасности, в том 

числе защиты 

государственной 

тайны  

Знает методы хранения, обработки, передачи 

информации, типовые программные продукты, 

ориентированные на решение научных, проектных 

и технологических задач направления 

Умеет использовать компьютерную технику для решения 

инженерных задач 

Владеет 

навыками работы с программными средствами 

управления экспериментом и обработкой данных 

ПК-2 

Готовность к 

математическому 

моделированию 

процессов и объектов 

приборостроения и их 

исследованию на базе 

стандартных пакетов 

автоматизированного 

проектирования и 

самостоятельно 

разработанных 

Знает основы математического программирования в 

программных пакетах Mathcad и Matlab 

Умеет работать с программными средствами 

математического программирования и 

автоматизированного проектирования 

Владеет 

навыками работы с программными средствами 

математического программирования и 

автоматизированного проектирования 



программных 

продуктов 

 

№ 

п/п 

Контролируемы

е модули/ 

разделы / темы 

дисциплины 

 

Коды и этапы формирования 

компетенций  

Оценочные средства - 

наименование 

текущий 

контроль 

промежуточна

я аттестация 

1 Персональный 

компьютер 

Способность 

осуществлять поиск, 

хранение, обработку и 

анализ информации из 

различных источников 

и баз данных, 

представлять ее в 

требуемом формате с 

использованием 

информационных, 

компьютерных и 

сетевых технологий 

(ОПК-2) 

Знает Устный 

опрос (УО-

1) 

Вопрос № 1-5 

в Приложении 

2 

Умеет Устный 

опрос (УО-

1) 

Вопрос № 6-

10 в 

Приложении 

2 

Владеет Устный 

опрос (УО-

1) 

Вопрос № 11-

15 в 

Приложении 

2 

2 Персональный 

компьютер 

Способность владеть 

методами 

информационных 

технологий, соблюдать 

основные требования 

информационной 

безопасности, в том 

числе защиты 

государственной 

тайны (ОПК-9) 

Знает Устный 

опрос (УО-

1) 

Вопрос № 16-

20 в 

Приложении 

2 

Умеет Устный 

опрос (УО-

1) 

Вопрос № 21-

25 в 

Приложении 

2 

Владеет Устный 

опрос (УО-

1) 

Вопрос № 26-

30 в 

Приложении 

2 

3 Математический 

программный 

пакет Mathcad 

Готовность к 

математическому 

моделированию 

процессов и объектов 

приборостроения и их 

исследованию на базе 

Знает Устный 

опрос (УО-

1) 

Вопрос № 31-

35 в 

Приложении 

2 



стандартных пакетов 

автоматизированного 

проектирования и 

самостоятельно 

разработанных 

программных 

продуктов (ПК-2) 

Умеет Устный 

опрос (УО-

1) 

Вопрос № 35-

40 в 

Приложении 

2 

Владеет Устный 

опрос (УО-

1) 

Вопрос № 41-

45 в 

Приложении 

2 

4 Математический 

программный 

пакет Matlab 

Готовность к 

математическому 

моделированию 

процессов и объектов 

приборостроения и их 

исследованию на базе 

стандартных пакетов 

автоматизированного 

проектирования и 

самостоятельно 

разработанных 

программных 

продуктов (ПК-2) 

Знает Устный 

опрос (УО-

1) 

Вопрос № 46- 

50 в 

Приложении 

2 

Умеет Устный 

опрос (УО-

1) 

Вопрос № 51-

55 в 

Приложении 

2 

Владеет Устный 

опрос (УО-

1) 

Вопрос № 56-

60 в 

Приложении 

2 

5 Программный 

пакет LabView 

Способность 

использовать 

современные 

программные средства 

подготовки 

конструкторско-

технологической 

документации (ОПК-7) 

Знает Устный 

опрос (УО-

1) 

Вопрос № 61- 

65 в 

Приложении 

2 

Умеет Устный 

опрос (УО-

1) 

Вопрос № 66-

70 в 

Приложении 

2 

Владеет Устный 

опрос (УО-

1) 

Вопрос № 71-

72 в 

Приложении 

2 

 

Код и 

формулировка 

компетенции 

Этапы формирования 

компетенции 

критерии  показатели 

Способность Знает Основные Знает основные Способность 



осуществлять 

поиск, хранение, 

обработку и 

анализ 

информации из 

различных 

источников и баз 

данных, 

представлять ее 

в требуемом 

формате с 

использованием 

информационны

х, 

компьютерных и 

сетевых 

технологий 

(ОПК-2) 

информационные, 

компьютерные и 

сетевые технологии 

информационные, 

компьютерные и 

сетевые 

технологии 

назвать 

основные 

информационн

ые, 

компьютерные 

и сетевые 

технологии 

Умеет Использовать 

компьютерную 

технику для поиска, 

хранения, 

обработки и 

анализа 

информации из 

различных 

источников и баз 

данных 

Умеет 

компьютерную 

технику для 

поиска, хранения, 

обработки и 

анализа 

информации из 

различных 

источников и баз 

данных 

Способность 

использовать 

компьютерную 

технику для 

поиска, 

хранения, 

обработки и 

анализа 

информации 

из различных 

источников и 

баз данных 

Владеет навыками анализа 

поставленной 

задачи 

исследований в 

области 

приборостроения 

Владеет навыками 

анализа 

поставленной 

задачи 

исследований в 

области 

приборостроения 

Способность 

анализа 

поставленной 

задачи 

исследований 

в области 

приборостроен

ия 

Способность 

использовать 

современные 

программные 

средства 

подготовки 

конструкторско-

технологической 

документации 

(ОПК-7) 

Знает Основные 

программные 

средства 

подготовки 

конструкторско-

технологической 

документации 

Знает основные 

программные 

средства 

подготовки 

конструкторско-

технологической 

документации 

Способность 

назвать 

основные 

современные 

программные 

средства 

подготовки 

конструкторск

о-

технологическ

ой 

документации 

Умеет Использовать 

современные 

программные 

средства 

подготовки 

конструкторско-

технологической 

документации 

Умеет 

компьютерную 

технику для 

подготовки 

конструкторско-

технологической 

документации 

Способность 

использовать 

компьютерную 

технику для 

подготовки 

конструкторск

о-

технологическ

ой 

документации 

Владеет навыками работы с 

программными 

средствами 

Владеет навыками 

работы с 

программными 

Способность 

подготовки 

конструкторск



подготовки 

конструкторско-

технологической 

документации 

средствами 

подготовки 

конструкторско-

технологической 

документации 

о-

технологическ

ой 

документации 

Способность 

владеть 

методами 

информационны

х технологий, 

соблюдать 

основные 

требования 

информационно

й безопасности, 

в том числе 

защиты 

государственной 

тайны (ОПК-9) 

Знает Методы хранения, 

обработки, 

передачи 

информации, 

типовые 

программные 

продукты, 

ориентированные 

на решение 

научных, 

проектных и 

технологических 

задач направления 

Знает основные 

типовые 

программные 

продукты, 

ориентированные 

на решение 

научных, 

проектных и 

технологических 

задач направления 

Способность 

назвать 

основные 

типовые 

программные 

продукты, 

ориентированн

ые на решение 

научных, 

проектных и 

технологическ

их задач 

направления 

Умеет Использовать 

компьютерную 

технику для 

решения 

инженерных задач 

Умеет 

использовать 

компьютерную 

технику для 

решения 

инженерных задач 

Способность 

использовать 

компьютерную 

технику для 

решения 

инженерных 

задач 

Владеет навыками работы с 

программными 

средствами 

управления 

экспериментом и 

обработкой данных 

Владеет методами 

информационных 

технологий, 

соблюдать 

основные 

требования 

информационной 

безопасности 

Способность 

использовать 

методы 

информационн

ых технологий 

Готовность к 

математическом

у 

моделированию 

процессов и 

объектов 

приборостроени

я и их 

исследованию на 

базе 

стандартных 

пакетов 

автоматизирован

ного 

проектирования 

и 

самостоятельно 

разработанных 

программных 

Знает Основы 

математического 

программирования 

в программных 

пакетах Mathcad и 

Matlab 

Знает основные 

пакеты 

математического 

программирования 

в программных 

пакетах Mathcad и 

Matlab 

Способность 

назвать 

основные 

пакеты 

математическо

го 

программиров

ания в 

программных 

пакетах 

Mathcad и 

Matlab 

Умеет Работать с 

программными 

средствами 

математического 

программирования 

и 

автоматизированно

Умеет 

компьютерную 

технику для работа 

с программными 

средствами 

математического 

программирования 

Способность 

работы с 

программными 

средствами 

математическо

го 

программиров



продуктов (ПК-

2) 

го проектирования и 

автоматизированно

го проектирования 

ания 

Владеет навыками работы с 

программными 

средствами 

математического 

программирования 

и 

автоматизированно

го проектирования 

Владеет навыками 

работы с 

программными 

средствами 

математического 

программирования 

и 

автоматизированно

го проектирования 

Способность 

работы с 

программными 

средствами 

математическо

го 

программиров

ания 

 

Методические рекомендации, определяющие процедуры оценивания 

результатов освоения дисциплины  

 

Текущая аттестация студентов. Текущая аттестация студентов по 

дисциплине «Прикладное программирование» проводится в соответствии с 

локальными нормативными актами ДВФУ и является обязательной. 

Текущая аттестация по дисциплине «Прикладное программирование» 

проводится в форме контрольных мероприятий (тесты, практические 

задания) по оцениванию фактических результатов обучения студентов и 

осуществляется ведущим преподавателем.  

Объектами оценивания выступают: 

- учебная дисциплина (активность на занятиях, своевременность 

выполнения различных видов заданий, посещаемость всех видов занятий по 

аттестуемой дисциплине); 

- степень усвоения теоретических знаний (активность в ходе 

обсуждений материалов лекций, активное участие в дискуссиях с 

аргументами из дополнительных источников, внимательность, способность 

задавать встречные вопросы в рамках дискуссии или обсуждения, 

заинтересованность изучаемыми материалами); 

- уровень овладения практическими умениями и навыками по всем 

видам учебной работы (определяется по результатам контрольных работ, 

практических занятий, ответов на тесты); 



- результаты самостоятельной работы (задания и критерии оценки 

размещены в Приложении 1). 

Промежуточная аттестация студентов. Промежуточная аттестация 

студентов по дисциплине «Прикладное программирование» проводится в 

соответствии с локальными нормативными актами ДВФУ и является 

обязательной. 

Вид промежуточной аттестации – устный опрос в форме 

собеседования. 

Краткая характеристика процедуры применения используемого 

оценочного средства. В результате посещения лекций, лабораторных 

занятий студент последовательно осваивает материалы дисциплины и 

изучает ответы на вопросы к экзамену, представленные в структурном 

элементе ФОС. Критерии оценки студента на экзамене представлены в 

структурном элементе ФОС. Критерии оценки текущей аттестации 

представлены в структурном элементе ФОС. 

 

Типовые задания к экзамену 

 

1. Mathcad. Общая характеристика, отличительные черты, 

преимущества и недостатки. 

2. Интерфейс Mathcad. Панели, меню, настройки, справка. 

3. Mathcad. Ввод информации, формульный и текстовый режим ввода, 

создание и редактирование формул, текста. 

4. Mathcad. Определение переменных, допустимые имена переменных 

и функций, ввод имен, содержащих операторы и специальные символы. 

Встроенные и пользовательские функции. 

5. Mathcad. Вычислительные, логические  операторы, операторы 

выражения. Определение глобальных переменных.  



6. Mathcad. Типы данных, комплексные числа и операции над ними, 

встроенные константы, строковые выражения, размерные переменные. 

Формат вывода числовых данных. 

7. Mathcad. Массивы, их типы, создание массивов, доступ к элементам 

массива,  действия над массивами, ранжированные переменные, создание 

тензора. 

8. Символьные вычисления в Mathcad. Способы символьных 

вычислений, виды преобразований, применение функций пользователя, 

получение численного значения выражения. 

9. Программирование в Mathcad. Язык программирования Mathcad, 

преимущества использования программных модулей, создание программы, 

локальное присваивание, условные операторы. 

10. Программирование в Mathcad. Язык программирования Mathcad, 

преимущества использования программных модулей, создание программы, 

операторы цикла, оператор break, return, перехват ошибок. 

11. Интегрирование в Mathcad. Оператор интегрирования, численное и 

символьное вычисление интеграла, алгоритмы численного интегрирования, 

возможные ошибки, расходящиеся интегралы, кратные интегралы. 

12. Дифференцирование в Mathcad. Оператор дифференцирования, 

численное и символьное дифференцирование, алгоритмы численного 

дифференцирования, типичные ошибки при вычислении производной, 

производные первого порядка и выше, частные производные, вычисление 

градиента. 

13. Mathcad. Специальные функции, определение, поиск и вставка 

нужной специальной функции, примеры специальных функций: функции 

Бесселя, Эйри, Бесселя-Кельвина, сферические функции Бесселя, функции 

для работы с комплексными числами, Логарифмы и экспонента, 

тригонометрические функции, функции сокращения и округления. 

14. Mathcad. Дифференциальные уравнения, начальные и граничные 

условия, задача Коши и краевые задачи. Описание задачи решения ОДУ 



первого порядка. Решение ОДУ первого порядка с помощью блока Given-

Odesolve и встроенных функций rkfixed, Rkadapt, Bulstoer.  

15. Mathcad. Дифференциальные уравнения, начальные и граничные 

условия, задача Коши и краевые задачи. Описание задачи решения ОДУ 

высшего порядка. ОДУ высшего порядка, системы ОДУ первого порядка, 

методы решения, особенности. 

16. Matlab. История создания, общая характеристика, отличительные 

черты, преимущества и недостатки. Обзор основных возможностей Matlab. 

Набор стандартных m-файлов системы. 

17. Общие принципы работы с пакетом Matlab, окна, запуск m-файлов 

пользователя, вывод файла помощи.  

18. Средства контроля рабочей области и файловой системы Matlab, 

меню системы, загрузка и сохранение файлов, работа с панелью 

инструментов. 

19. Matlab. Основы редактирования и отладки m-файлов, понятие о 

файлах-сценариях и файлах-функциях, операции строчного редактирования, 

команды управления окном. 

20. Основные объекты MATLAB. Действительные и комплексные 

числа, константы и системные переменные, текстовые комментарии,  

переменные и присваивание им значений, уничтожение определений 

переменных. 

21. Операторы и функции MATLAB. Применение оператора ":". 

Сообщения об ошибках и исправление ошибок. 

22. Форматы чисел в MATLAB, операции с рабочей областью и 

текстом сессии, завершение вычислений и работы с системой. 

23. Основы графической визуализации вычислений MATLAB. Графики 

функций в декартовой системе координат, в логарифмическом масштабе, 

столбцовые диаграммы, построение гистограмм, графики в полярной системе 

координат. 



24. Основы графической визуализации вычислений MATLAB. 

Контурные графики, построение трехмерных графиков поверхностей, 

сетчатых 3D-графиков с окраской, трехмерных контурных графиков. 

25. Основы графической визуализации вычислений MATLAB. 

Установка титульной надписи, установка осевых надписей, вывод пояснений, 

управление свойствами осей графиков, включение и выключение сетки, 

разбиение графического окна, Установка палитры цветов. 

26. Операции с векторами и матрицами в MATLAB. Формирование 

векторов и матриц, объединение матриц, удаление столбцов и строк матриц, 

создание матриц с заданными свойствами. 

27. Операции с векторами и матрицами в MATLAB. Вычисление 

произведений, суммирование элементов, поворот матриц. 

28. Матричные операции линейной алгебры в MATLAB. Вычисление 

нормы матрицы, определитель и ранг матрицы, обращение матриц, работа с 

многомерными массивами. 

29. Численные методы в MATLAB. Элементарные средства решения 

СЛУ, вычисление конечных разностей и градиента функции. 

30. Численное интегрирование  в MATLAB. Метод трапеций, метод 

квадратур. 

31. Решение обыкновенных дифференциальных уравнений в 

MATLAB. Преобразования Фурье в MATLAB. 

 

Оценочные средства для промежуточной аттестации 

 

Типовые контрольные вопросы 

 

1. Понятие информации. Термин «информация». Понятия "сигнал", 

"сообщение" и "данные". Непрерывная и дискретная формы представления 

информации. Виды информации. 

2. Понятие количества информации. Энтропия. Минимальная 



единица количества информации. Связь между количеством информации и 

числом состояний системы.  

3. Понятие архитектуры ЭВМ, классификация ЭВМ, структура и 

принципы функционирования ЭВМ, основные характеристики 

вычислительной техники. 

4. Виды программного обеспечения ЭВМ. Операционная система, 

понятие, функции, эволюция операционных систем и основные идеи. 

5. Персональный компьютер: определение, история развития. 

6. Принципы устройства современного персонального компьютера. 

Процессор: принципы работы, конвейерная архитектура, конвейерная 

архитектура, процессорная шина, кэширование, параллельная архитектура. 

7. История развития процессоров. Характеристика этапов развития 

процессоров. 32- и 64-битный режим работы. 

8. Чипсет: устройство, состав, принцип работы. Разъём 

центрального процессора. 

9. Материнская плата. Форм-фактор. Разъёмы питания.  

10. Материнская плата. Шина, определение, виды, их эволюция, 

принципы работы. 

11. Оперативная память. Определение, принцип работы, виды, их 

эволюция. 

12. Корпус системного блока: виды, отличия. Блок питания: 

характеристики, упрощенная структура блока питания. Кабели питания.  

13. Накопитель на жестких магнитных дисках: устройство, принцип 

работы. Способы повышения надежности хранения данных.  

14. Приводы CD, DVD: устройство, принцип работы. Основные 

параметры приводов.  

15. Накопители на гибких магнитных дисках, магнитооптические, 

ленточные, твердотельные накопители: устройство, принцип работы, 

основные параметры. 

16. B I O S. Устройство, принцип работы, основные параметры, 



настройка. Процедура POST. 

17. Загрузка персонального компьютера. Этапы загрузки с описанием 

возможных неисправностей. 

18. Файловые системы. Определение, функции, задачи, 

разновидности, структура каталогов. 

19. Файловые системы. FAT16, FAT32, NTFS: структура, принцип 

работы, отличия, рассмотрение возможных сбоев и ошибок. 

20. Операционная система. Понятие, функции, задачи, состав. 

Эволюция операционных систем, развитие идей. «Юникс», стандартизация 

ОС и открытые ОС. Хронология развития операционных систем. 

21. Настройка и работа в операционной системе Windows. 

Конфигурирование системы: панель управления, средства управления 

системой, утилиты командной строки, справочная система Windows. 

22. Настройка и работа в операционной системе Windows. 

Системный реестр, его назначение, структура. Средства резервного 

копирования и восстановления Windows.  

23. Настройка и работа в операционной системе Windows. Сетевые 

подключения: типы, управление, подключение к локальной вычислительной 

сети. 

24. Компьютерная сеть: определение, модель OSI, протоколы, 

примеры протоколов с их описанием.  

25. Компьютерная сеть.  Сеть Ethernet: история развития, принцип, 

метод доступа, стандарты. 

26. Internet Protocol, IP-адрес, протоколы TCP, UDP, сетевые порты, 

примеры соответствия сетевых служб и портов. Протоколы HTTP, FTP, 

POP3, SMTP. 

27. Всемирная паутина - WWW. Определение, структура и 

принципы, веб-сервер, URL (с примерами), язык HTML, XML. 

28. История Всемирной паутины - WWW. Доменная система имён, 

служба DNS, структура доменной системы. 



29.  Поиск в Интернете. Каталог ресурсов в Интернете: история 

создания и примеры. Поисковые системы: определение, история развития, 

принцип работы, популярные современные поисковые системы.  

30. Популярные современные поисковые системы в Интернете. 

Основные правила эффективного поиска в Интернете. Специализированные 

и тематические поисковые системы, Научная литература в интернет. 

31. Mathcad. Общая характеристика, отличительные черты, 

преимущества и недостатки. 

32. Интерфейс Mathcad. Панели, меню, настройки, справка. 

33. Mathcad. Ввод информации, формульный и текстовый режим 

ввода, создание и редактирование формул, текста. 

34. Mathcad. Определение переменных, допустимые имена переменных 

и функций, ввод имен, содержащих операторы и специальные символы. 

Встроенные и пользовательские функции. 

35. Mathcad. Вычислительные, логические  операторы, операторы 

выражения. Определение глобальных переменных.  

36. Mathcad. Типы данных, комплексные числа и операции над ними, 

встроенные константы, строковые выражения, размерные переменные. 

Формат вывода числовых данных. 

37. Mathcad. Массивы, их типы, создание массивов, доступ к элементам 

массива,  действия над массивами, ранжированные переменные, создание 

тензора. 

38. Символьные вычисления в Mathcad. Способы символьных 

вычислений, виды преобразований, применение функций пользователя, 

получение численного значения выражения. 

39. Программирование в Mathcad. Язык программирования Mathcad, 

преимущества использования программных модулей, создание программы, 

локальное присваивание, условные операторы. 

40. Программирование в Mathcad. Язык программирования Mathcad, 

преимущества использования программных модулей, создание программы, 



операторы цикла, оператор break, return, перехват ошибок. 

41. Интегрирование в Mathcad. Оператор интегрирования, численное и 

символьное вычисление интеграла, алгоритмы численного интегрирования, 

возможные ошибки, расходящиеся интегралы, кратные интегралы. 

42. Дифференцирование в Mathcad. Оператор дифференцирования, 

численное и символьное дифференцирование, алгоритмы численного 

дифференцирования, типичные ошибки при вычислении производной, 

производные первого порядка и выше, частные производные, вычисление 

градиента. 

43. Mathcad. Специальные функции, определение, поиск и вставка 

нужной специальной функции, примеры специальных функций: функции 

Бесселя, Эйри, Бесселя-Кельвина, сферические функции Бесселя, функции 

для работы с комплексными числами, Логарифмы и экспонента, 

тригонометрические функции, функции сокращения и округления. 

44. Mathcad. Дифференциальные уравнения, начальные и граничные 

условия, задача Коши и краевые задачи. Описание задачи решения ОДУ 

первого порядка. Решение ОДУ первого порядка с помощью блока Given-

Odesolve и встроенных функций rkfixed, Rkadapt, Bulstoer.  

45. Mathcad. Дифференциальные уравнения, начальные и граничные 

условия, задача Коши и краевые задачи. Описание задачи решения ОДУ 

высшего порядка. ОДУ высшего порядка, системы ОДУ первого порядка, 

методы решения, особенности. 

46. Matlab. История создания, общая характеристика, отличительные 

черты, преимущества и недостатки. Обзор основных возможностей Matlab. 

Набор стандартных m-файлов системы. 

47. Общие принципы работы с пакетом Matlab, окна, запуск m-файлов 

пользователя, вывод файла помощи.  

48. Средства контроля рабочей области и файловой системы Matlab, 

меню системы, загрузка и сохранение файлов, работа с панелью 

инструментов. 



49. Matlab. Основы редактирования и отладки m-файлов, понятие о 

файлах-сценариях и файлах-функциях, операции строчного редактирования, 

команды управления окном. 

50. Основные объекты MATLAB. Действительные и комплексные 

числа, константы и системные переменные, текстовые комментарии,  

переменные и присваивание им значений, уничтожение определений 

переменных. 

51. Операторы и функции MATLAB. Применение оператора ":". 

Сообщения об ошибках и исправление ошибок. 

52. Форматы чисел в MATLAB, операции с рабочей областью и 

текстом сессии, завершение вычислений и работы с системой. 

53. Основы графической визуализации вычислений MATLAB. Графики 

функций в декартовой системе координат, в логарифмическом масштабе, 

столбцовые диаграммы, построение гистограмм, графики в полярной системе 

координат. 

54. Основы графической визуализации вычислений MATLAB. 

Контурные графики, построение трехмерных графиков поверхностей, 

сетчатых 3D-графиков с окраской, трехмерных контурных графиков. 

55. Основы графической визуализации вычислений MATLAB. 

Установка титульной надписи, установка осевых надписей, вывод пояснений, 

управление свойствами осей графиков, включение и выключение сетки, 

разбиение графического окна, Установка палитры цветов. 

56. Операции с векторами и матрицами в MATLAB. Формирование 

векторов и матриц, объединение матриц, удаление столбцов и строк матриц, 

создание матриц с заданными свойствами. 

57.  Операции с векторами и матрицами в MATLAB. Вычисление 

произведений, суммирование элементов, поворот матриц. 

58. Матричные операции линейной алгебры в MATLAB. Вычисление 

нормы матрицы, определитель и ранг матрицы, обращение матриц, работа с 

многомерными массивами. 



59. Численные методы в MATLAB. Элементарные средства решения 

СЛУ, вычисление конечных разностей и градиента функции. 

60. Численное интегрирование  в MATLAB. Метод трапеций, метод 

квадратур. 

61. Решение обыкновенных дифференциальных уравнений в MATLAB. 

Преобразования Фурье в MATLAB. 

62. Особенности NI LabVIEW 2010, новые возможности.  

63. Базовые функции LabVIEW, предназначенные для генерации, 

фильтрации и спектрального анализа сигналов. 

64. Тип данных Waveform: состав, назначение. 

65. Узлы свойств Property Node – назначение, возможности, методы 

создания и настройки. 

66. Модульная система сбора данных NI CompactDAQ, ее назначение и 

типовые конфигурации. 

67. Кластер ошибок: состав и назначение. Функции и средства для 

работы с ним. 

68. Расширенный файловый ввод/вывод и его отличие от стандартного. 

69. Концепция и механизмы создания отчетов в LabVIEW. 

70. Работа с базами данных в LabVIEW: инструменты Database 

Connectivity (состав, структура формирования запросов к базам данных).  

71. Обработка событий в NI LabVIEW (структура типа Event, краткая 

характеристика Timed Loop и методы их синхронизации). 

72. Создание инсталлятора со своим приложением из проекта 

LabVIEW. 

73. Сетевые механизмы передачи данных в LabVIEW. 

 

 

 

 

 



 

Критерии и показатели, необходимые для оценки знаний, умений, 

навыков и характеризующие этапы формирования компетенций в 

процессе освоения образовательной программы 

 

Оценка зачета/ 

экзамена 

Требования к сформированным компетенциям 

 

«зачтено» / 

«отлично» 

Оценка «отлично» выставляется студенту, если он глубоко и 

прочно усвоил программный материал, исчерпывающе, 

последовательно, четко и логически стройно его излагает, умеет 

тесно увязывать теорию с практикой, свободно справляется с 

задачами, вопросами и другими видами применения знаний, 

причем не затрудняется с ответом при видоизменении заданий, 

использует в ответе материал монографической литературы, 

правильно обосновывает принятое решение.  

«зачтено»/ 

«хорошо» 

Оценка «хорошо» выставляется студенту, если он твердо знает 

материал, грамотно и по существу излагает его, не допуская 

существенных неточностей в ответе на вопрос, правильно 

применяет теоретические положения при решении практических 

вопросов и задач, владеет необходимыми навыками и приемами их 

выполнения. 

«зачтено» / 

«удовлетворите

льно» 

Оценка «удовлетворительно» выставляется студенту, если он 

имеет знания только основного материала, но не усвоил его 

деталей, допускает неточности, недостаточно правильные 

формулировки, нарушения логической последовательности в 

изложении программного материала, испытывает затруднения при 

выполнении практических работ. 

«не зачтено» / 

«неудовлетвори

тельно» 

Оценка «неудовлетворительно» выставляется студенту, который 

не знает значительной части программного материала, допускает 

существенные ошибки, неуверенно, с большими затруднениями 

выполняет практические работы. Как правило, оценка 

«неудовлетворительно» ставится студентам, которые не могут 

продолжить обучение без дополнительных занятий по 

соответствующей дисциплине. 

 

 


